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FireFamilyPlus is a powerful tool that allows you to summarize and analyze various aspects of 
climatology and fire business and to analyze the relationships between the two. This software 
works with an integrated Microsoft Office Access®  database containing both fire weather and 
fire occurrence data.  
  
In S-491 you will be using this program to troubleshoot NFDRS outputs as well as to analyze 
relationships between various NFDRS outputs and fire occurrence to determine which of the 
outputs will be the best indicator of your unit's fire problems. 
  
The purpose of this section of pre-course work is to ensure basic familiarity with the screen 
layout and general functionality of FireFamilyPlus. You will go through the various steps 
outlined below. Steps you will take are highlighted in bold print, but do not skip the other 
information that is not in bold print. The > symbol between words indicates a series of 
command steps in FireFamilyPlus. 
  
The FireFamilyPlus User's Guide, installation files, Tech Tips, and the database used for the 
S-491 Course can be found on the Internet at http://FireModels.org. 
  
Examples in the User's Guide and Tech Tips can be very helpful in becoming familiar with the 
program. You will be asked to perform certain FireFamilyPlus functions and return the 
output products and quiz questions, located at the end of this tutorial, with your completed 
pre-course work package.

OBJECTIVES: 
  

1. Demonstrate the ability to operate FireFamilyPlus basic functions. 
2. Demonstrate the ability to define a working set in FireFamilyPlus. 
3. Demonstrate the ability to produce a climatological graph. 
4. Demonstrate the ability to read FireFamilyPlus graphs.



A. Do you have FireFamilyPlus 4.0.2 (or later) installed on your computer?  
You can tell from the start menu (Start > All Programs) and look for the 
FireFamilyPlus 4 program group. You may also have, or can create a shortcut to 
FireFamilyPlus 4. 

 

  
You can determine the exact version by starting FireFamilyPlus 4 and clicking on 
the task bar item Help and then click on "About FireFamilyPlus" from the drop-
down menu. 
 

  
The text should read "FireFamilyPlus, Version 4.0.2" (or later). 
  

*  If a current version of FireFamilyPlus 4 is not installed on your 
computer, continue with step B (below).  

  
*  If a current version of FireFamilyPlus 4 is installed on your computer, 

(skip step B) go directly to step C. 
 

B. You can download the latest version 
of FireFamily Plus from the Internet 
site http://FireModels.org. 
 
Click on "FireFamilyPlus" then 
"Downloads" to access the download 
page.

I. DOWNLOAD/UPDATE PROGRAM AND DATABASE 
  

Check your FireFamilyPlus version (if currently installed), update if necessary, or install 
FireFamilyPlus if it is not on your computer. 
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Follow the instructions to download and save the installation file "ffp4setup.msi" 
which contains everything needed to install the program. 
  

Note: You may also review the online release notice for detailed installation 
instructions (                                                      ). 

  
Depending on your agency, you may need assistance from your computer staff to 
install the software. Install FireFamilyPlus by double-clicking on the file 
ffp4setup.msi in Windows Explorer and clicking the Next button each time it 
appears, and then click the Finish button to complete installation.

C. There are two recommended methods for downloading the S-491 Class Database 
from the FireFamilyPlus Training Page (Support > Training) at http://FireModels.
org.
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firefamilyplus4_release_note.pdf

http://firemodels.fire.org/downloads/firefamilyplus/4.0/firefamilyplus4_release_note.pdf


  
Do one of the following: 
  
1. Left-click on the Microsoft Office Access® database: 
  

Save the database in a location of your choice. This example puts it in the 
FireFamily Plus program directory.  In some cases, the file extension 
defaults to "accdb" (Microsoft Office Access® 2007 Database).  Before 
saving the file, make sure the file extension is "mdb".

  
2. Right-click on the PKZip® file containing the database:   
  

  
Save the database in a location of your choice. Navigate to the directory 
containing the file and double-click on the ZIP file to extract the S-491 
Class Database (                         ).  
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s491_class_database.zip

s491_class.mdb

s491_class.mdb

http://firemodels.fire.org/downloads/firefamilyplus/training/s491_class.mdb
http://firemodels.fire.org/downloads/firefamilyplus/training/s491_class.mdb
http://firemodels.fire.org/downloads/firefamilyplus/training/s491_class_database.zip


II. FIREFAMILYPLUS 
  

A. Start FireFamilyPlus by one of the following methods: 
  

1. Double-clicking on the FireFamilyPlus 4 Icon (shortcut) located on the 
desktop 

2. Start Bar > Programs > FireFamilyPlus 4 > FireFamily Plus 4 
3. Double-click on the application file (fireplus4.exe) in the FireFamilyPlus 4 

program directory 
  

Note:  The program will automatically open the last database used. 
  

B. Open the s491_class.mdb FireFamilyPlus dataset for the exercise: 
  

1. From the Main Menu: Click on File > Open 
2. Browse to the C drive folder (section I.C. on page 3)  
3. Select s491_class.mdb, and click Open 
  

Note:  FireFamily is a Microsoft Access database hence the .mdb extensions 
on all dataset files. 

  
C. Working Set 
  

The window that opens is called the Working Set, which is the heart of 
FireFamilyPlus. Almost everything FireFamilyPlus does relies on the 
configuration of the working set. Yours will probably contain information that is a 
little different from that shown below.
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The working set is essentially a filter of the active database and the Active 
Working Set Definition is stored as part of the open database. FireFamilyPlus 
allows you to create and populate new databases, and have multiple databases 
open. (Only one is 'active' at a time, although several may be open). 
  
Why is the working set important? Again, it is your filter into the database and 
controls what data you will be looking at.  
  
There are several important input areas on the working set window: 
  
1. Database Name - this computer file will always end in .mdb. The database 

name is shown with complete address so you can see where it is filed.  
  
2. Description - descriptive information about the database that the user can 

supply.  
  
3. Active Working Set Definition - the most important part of the working set 

is the Active Working Set Definition. 
 

  
SIG/Station - where a weather station or Special Interest Groups 
(SIG) is selected.  Press the drop-down arrow to the right of the field and see 
which stations are currently in this working set. 
  
Data Years (yyyy thru yyyy) - identifies the years of weather that are 
available to the working set for each station or SIG. There may be more 
years of data available outside FireFamilyPlus, but what is shown are the 
years that have been put into this dataset. The years that appear in the two 
windows below the Data Years title are the years for which the current 
analysis (Analysis Years) will be performed. Click the small up or down 
arrow at the right side of year each to increase or decrease the year. 
You can also highlight the year (using the left mouse key) and type in a 
year.
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Enable Auxiliary Years Overlays - Checking the Enable Auxiliary Years 
Overlays allows you to specify whether you want to overlay years outside 
the years shown in the Analysis Years windows on a statistical graph. A 
check in this field activates the function. Auxiliary year data are not used in 
statistics (average, max/min). Most commonly it is used when you want to 
overlay the current year over a previous set of data, such as this year plotted 
over the average for the past 10 years. Click in the small box to the left of 
the Enable Auxiliary Years Overlays to add and then click again to 
remove the check mark. 
  
Analysis Period Length (Days) - allows the user to specify the length of 
time represented by a plotted point. It can be set from 1 to 28 days. If the 
value is set at 1, you will get each day plotted individually. If set to three 
day, for example, the program groups the data in three day periods, takes 
the average and uses that average to represent those three days…. then the 
next three days etc. Here's an example of a three day average using letters in 
the alphabet to represent numbers:  abcdefghijkl = average of (abc), average 
of (def), average of (ghi), average of (jkl). Click the down arrow and 
scroll down to view the choices. If you chose 28 days, the analysis is 
completed by one-month periods. 
  
Annual Filter - you can pick specific dates (Month and Day) to start (top 
fields) and end (bottom fields) your analysis. This allows you to analyze 
data for various lengths of fire seasons or for the full year. Click on the 
drop-down arrow to the right of the field under Month to view the month 
pick list. Start and end months are selected from this list. The day of the 
month is chosen by clicking the up or down arrows under Day or by 
highlighting the number in the field and entering your choice directly. 
  
Fire Associations - will open a window for selecting or viewing fire 
occurrence data from the area represented by the weather station or SIG 
shown in the active working set definition window. Make sure the Moose 
Creek station is selected. Click the Fire Associations button and view 
the window that opens. It will show the Northern Region highlighted from 
the Regions list and it will highlight the National Forest associated with the 
particular station listed in the SIG/Station field. Notice there are tabs for all 
of the national wildland fire agencies. States and local agencies can also be 
created as custom agencies. Click the cancel button on the Set Fire 
Association window to close the window without making any changes. 
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4. SIG/Station Metadata - is the final part of the Working Set. It is a set of 
NFDRS station catalog information for the weather station or SIG selected 
in the Active Working Set Definition. Slide the bar at the bottom of the 
screen to see all the fields available. 

 

  
D. Menus and Buttons 

  
Summary of Main Menu drop-downs: 
  
As you read through the descriptions below, click on each of the items in the 
drop-down menus to become familiar with their location in FireFamilyPlus and view
 the various windows that open up. 

1. File > 

New - Create a new database. The database will lack weather and 
fire records but contains the default Agency Structures for fire 
occurrence and station catalog data for most fire weather stations. 

Open - Open an existing database file. 

Close - Close the current working set but does not exit FireFamilyPlus. 

Save - Save the current working set. 

Save As - Save the current working set with a new name or location. 

Print - Print active window or choose which graph to print. 

Print Setup - Define printer characteristics.

Note:  FireFamilyPlus also 
keeps track of the four most 
recently used files and will 
present paths to these files on 
the File menu option.

Exit FireFamilyPlus  - Save the current working set and exit.
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2. Data > 
  

Import - Import station metadata, weather data and fire occurrence data file 
types.

These files can be obtained from the FAMWEB Data Warehouse, 
from agency prepared CDs, or other data sources. 
  
Stations - imports catalog information for weather stations cataloged 

in WIMS.  
Weather - imports weather observations from several sources.  

• Old FWX Files (*.fwx)  
• New FW9 Files (*.fw9)  
• Generic Weather Import  
• WRCC RAWS import option allows you to import 

hourly RAWS data from the Western Region Climate 
Center's Data Lister (http://www.raws.dri.edu).  

Fires - imports agency specific fire occurrence data.  
  
To support the integration of fire occurrence data in FireFamilyPlus, 
the default database is populated with the current organizational 
structures (up to three levels) of Forest Service and DOI agencies. 
Generically it is considered to be region/unit/subunit. 
  
The program is designed to correctly import a variety of fire 
occurrence types:  

• Forest Service data is imported as a RAW fire occurrence 
file, organized by Region/Forest/District.  

• The DOI agencies use the Wildland Fire Management 
Information System (WFMI). The WFMI Fire import option 
is used for these agencies, organized by NWCG unit 
identifiers.
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 • A generic import function allows other agencies to import 
other fire occurrence data, organized by your custom 
defined structure. 

  
Stations  - Shows a list of all the stations in the database that have weather 
data.  You can edit (or view) the station catalog information.  You can also 
delete a station, create a new station catalog, or export the list.  Checking 
the “Show All” box at the lower left of the dialog box will display all station 
catalogs available in FireFamilyPlus. 
  
SIGS  - Allows you to set or edit characteristics of Special Interest Groups 
(create a new SIG, edit, delete, set station weights, and export). Each 
observation is averaged across the stations in the SIG. FireFamilyPlus uses 
these averages for graphs and statistics. Stations can each be given a unique 
weight when computing averaged values. Special care must be taken when 
using SIGS to ensure that station catalogs are specifying the same NFDRS 
fuel model and fuel model set (78 or 88) if meaningful outputs are to be 
obtained. 
  
Agencies  - Create, edit (identify administrative structure for unique fire 
occurrence datasets) or delete agencies added to FireFamilyPlus database. 
  
User Variables  - Allows import of user-defined variables.  Users can 
associate variables with an existing weather station (manage, import data 
and view observations). 
  
Compact - Compacts database removing spaces left by deleted weather 
stations or fire occurrence records. Typically when records are deleted from 
the FireFamilyPlus database, they are 'marked' for deletion and are not 
visible, but occupy storage space until the database is compacted, packed, or 
saved with a new file name. 
  

3. Weather > 
  

Climatology  - Display of historical information, both weather observations 
and calculated NFDRS output values, to get a feel for previous conditions or 
make comparisons between years. Reports and graphs in climatology are 
based on the working set. 
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There are two action buttons: 
• Clear All will clear any previous selections 

• Run will start the climatology analysis based on your 
selections 

This window contains six columns of options for each data output variable. 
  

Stats Table: Generates a table displaying base statistics for the 
selected variable. These statistics are grouped by time period, and 
then summarized by month. 
  
Stats Graph: Statistical graphs are produced with two-part graphical 
display of values. The left graph is a plot of the average and historical 
maximum and minimum values for the weather for the fire danger 
element selected for display (grouped by analysis period length). The 
right graph is a cumulative frequency distribution curve of daily 
values.  The lower right hand corner of either graph displays the 
number of observations in the dataset used to produce the graphic 
display. 
  
CP#1 and CP#2  - These define two different critical percentile levels 
to be overlaid on the graphic displays as horizontal lines or listed in 
reports. These could represent different critical values such as 80th 
and 95th or 90th and 97th percentile climatological breakpoints. 
  

 CP #1: This is the first critical percentile for the variable.  
This percentile is displayed on Stats Table reports, percentile 
graphs, and optionally on Bar Graphs. 
  
CP #2: This is the second critical percentile. The second 
critical percentile is always visible on percentile graphs.
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Daily Freqs: Selecting this option will generate a daily frequency 
report for the variable. It shows a tabular display of the count, relative 
and cumulative frequencies of each value in a distribution. A quick 
way to determine percentile values as the selected Critical Percentile 
values are generated at the top of the report. 
  
Data Count: Selecting this option will cause a data count report to be 
generated for the variable. It shows a tabular display of the number of 
observations available by analysis period group (number of days) for 
each year in the active working set. This report is useful for 
determining if the dataset is complete.  
  
To make a selection, click inside any of the boxes. This will place a 
check mark in the box. Click again and the check will be removed. 
  
Event Locator  - a tool for searching for events or combinations of 
events based on weather values and /or calculated indices. This tool is 
useful for searching for rare occurrences, and is also useful for 
checking for bad or erroneous data.  You can also specify one or 
more variables and a value or percentile to use as a benchmark in a 
search. FireFamilyPlus will list all dates and the value of the 
variables meeting the criteria. 
  
Fire Danger Projections  - Enter historic or forecast weather to 
calculate NFDRS outputs for that projected weather. 
  
Hourly Data Analysis  - Allows processing for hourly weather 
statistics.    

• Calculates and graphs diurnal fluctuations in fire danger 
indices and weather values.   

• Creates hourly listing of data and indices.   
• Exports FARSITE weather and wind files.   
• Includes the Nelson Dead Fuel Moisture Model for 

analysis options (hourly values and comparison with 
daily NFDRS). 

  
Pocket Card  - a Pocket Card, used for firefighter safety, can be 
created after an analysis has been completed on the fire and weather 
data. It is a color coded card illustrating current fire danger as it 
relates to average and important fire seasons.
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Season Reports  - Generates a variety of tables/reports useful for 
weather data analysis. 

• Persistence Probability - reports based on the question: 
Given these conditions, what is the probability of having 
these conditions tomorrow?  

• Severity List - lists all of the occurrences of an index 
above or below a specified percentile value.  

• Severity Summary - analyzes cumulative and daily 
departures of an index value above or below a specified 
percentile value by time period. 

• Probability Analysis - reports based on the question: 
Given these conditions for variable "a", what are the 
chances of having these conditions for variable "b."     

• Daily Listing - lists user selected weather and/or NFDRS 
outputs.     

• Percentile Weather - reports fuel moisture values and 
wind associated with user defined adjective class fire 
danger for a selected variable, often spread component. 
The output is used in RERAP (Rare Event Risk 
Assessment Process) analysis.  

• FlamMap Fire Risk Export 
  
Winds  - produces tables and wind roses summarizing wind speed by 
wind direction. 
  
Term  - function used to analyze waiting times to season-ending or 

fire-stopping events. Can be linked to dates found in the Event 
Locator. (Term is included in releases greater than 4.0.2.1) 

  
View Observations  - opens an editable display of weather 

observations that meet the criteria you have designated in the 
working set. You can edit, delete or export data from here. 
Selecting View Observations > All, all 24 hours of data (both 
“R” and “O”) are displayed. Selecting View Observations > 
Daily only the once daily observation (“O” type) is displayed. 

  
NFDRS Calculator  - Opens the calculator. User can input fuel 

model choices and fuel moistures and calculator displays 
NFDRS Indices.
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Custom Yearly Inits (Initialization)  - Supports the Canadian 
systems snow-off start up and allow for variable greenup dates from 
year to year. 
  

4. Fires > 
  

Associations  - Links fire occurrence data records to current working 
set weather station or SIG via agency(s) and their organizational 
structures. Note that this is the same function as the button located in 
the working set. 
  
Summary  - Graphical summary of fire numbers, size, cause, etc. 

• General - displays graph for all years for the unit(s) 
identified by Fire Associations in this option.  

• Working Set - displays graph for only date ranges and 
fire associations in the Active Working Set.  

To verify that only the desired fire associations are selected, click 
View Selections.  
  
To review the fire occurrence data, click View Fires.  
  
To review the fire occurrence summary graphic, click OK. 
  
The fire summary has five sections displaying fire data. The box on 
the top left shows total fires and acres by year. On the left axis is the 
information about the number of fires and the right axis is the acres. 
The top right box is the number of fires by month. Remember, if you 
select by Working Set you can limit the months you want to see. 

The illustration below was limited to May 1 through October 31. The 
number of fires by size class and cause class are shown on the bottom 
panel. If you click Options > View Class Definitions, you can see 
the size and cause classes. The bottom right panel shows the number 
of fires by fire day.  The illustration below shows that most fire days
(600) had only 1 fire per day, but there were 205 days that had 2 fires,
106 days that had 3 fires, etc.
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 Fire Summary Graph

Fire Analysis  - performs cumulative probability and logistic 
regression analysis of joint fire weather and fire occurrence datasets. 
  
Fire Business Candidates  - goodness of fit statistics from Fires 
Analysis are collected in the candidates table. Saved statistics can be 
viewed using the Fires > Fire Business Candidates function. 
  

5. Options >  
  

Graph Options  - FireFamilyPlus task bar allows adjusting the 
graphic display format for various outputs of FireFamilyPlus. These 
are more advanced applications and will be covered in detail in the 
course or learned through subsequent use of the program, User's 
Guide, or the Help System. They include setting graph style and 
content, line color, style and width, and fire-day definition. Some of 
the graph options include type (Bar vs Line), what statistics to include 
(ranges, percentiles , etc), line colors and thickness, and what fire-
days to include on overlay years.  
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Report Options  - Define what metadata to include in report headers 
and if desired, a column delimiter to enable easy import of a daily list 
report into a spreadsheet.  
  
Batch/Run Options  - Define default run titles and where auto 
generated batch output files are saved.  
  
LFI Options  - Set parameters for Live Fuel Index, including 
thresholds and averaging periods. 

  
6. Batch > 
  

FireFamilyPlus v.4 has two batch functions: 
• Interactive batch generates many reports for any number 

of stations at once.  
• Batch Runs enable a number of specified reports to be 

repeated for new data using the same working set 
parameters. Fundamental to using batch is the concept of 
saving runs. If you enable run saving, all the elements 
are saved as sequentially numbered runs. 

Create new batch  - Create a new batch from two or more saved 
runs.  
  
Manage batch list  - Edit or delete existing batch lists.  
  
Interactive  - Start an interactive batch session. 
  
Restore previous run settings  - Restore working set settings from a 
previously saved run.  
  
Saved run maintenance  - Employ a saved run maintenance 
strategy. 
  
Enable Run Saving  - Toggle run saving on or off. 
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7. Windows > 
  

Cascade  - Display open windows cascade style.  
  
Tile Horizontal  - Display open window tiles horizontally.  
  
Tile Vertical  - Display open window tiles vertically.  
  
Close All 

• Reports and Graphs  - Close all report and graph 
output windows associated with the active working set, 
but not the working set.  

• Windows  - Close all report and graph output windows 
including the working set.  

  
Switch to Selected Window  - If a number of display windows are 
open, you can go directly to the window from the window list below 
the Close All line. 
  

Note: the Arrange Icons does not work at this time. 
  

8. Help > 
  
Help takes you to a FireFamilyPlus Help Utility. You can either 
locate topics by going to the Contents or by doing a Topic search 
  
Contents  - Open the Help file to search or display table of contents. 
  
Open Help  - Open the Help file to search or display table of 
contents. 
 

Summary of Main Menu Buttons (shortcuts): 
  
  
  
The Main Menu Buttons are shortcuts to some of the frequently used tasks 
in FireFamilyPlus. To see where a Button takes you, hover the mouse 
cursor over the button and a tiny definition window will open. Buttons 
are only active when they can be used.
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E. FireFamilyPlus Graphs 
  

The following two illustrations point out the parts of a climatology graph produced 
in FireFamilyPlus.  Become familiar with the graphs, as you will be creating 
them in the S-491 class.
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1. What is the default description associated with the S491_class database? 

2. How many Stations and how many SIGS are included in the S491_class database?

3. What data years are available for Logan (020107) and Mamoth (480111) and what stations are in 
Sample SIG (SIG)? 

4. Produce a Statistics Graph display showing the historic maximum, minimum and average daily dry 
bulb temperature for Moose Creek covering the period 7/1-9/15 for the years 1988-1997. (Weather 
=> Climatology => Stats Graph for Dry Bulb Temperature).  

  

PRINT THE GRAPH (File => Print => Graph in FireFamilyPlus) attach it to this page and return 

with the other pre-course work questions. 

5. How many observations are used to produce the above Statistics Graph display? 

6. Within the active working set used in question 4, how many Class C and larger fires occurred during 
the period covered by the active working set? (Fires => Summary => Working Set). 

7. What is the last item listed under the Index display of the FireFamily Help function?  
 (Help => Contents => Click on the Index tab => scroll down)

For the following two questions, you will be asked to list sequential menu selections.  For example, if the question 
asks:  “What two menu steps will open an existing database in FireFamilyPlus”, you would answer File > Open.

8. Which two menu steps allow you to view all of the stations in the database?

9. Which menu steps open a table of daily weather observations for the working set data?

Name: Date:
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